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Getting Started
Complete Activation Process for New Users

Preliminary Preparations

Registering an account

A Note:
This is exclusively for administrators and may involve the following operations.

1. Navigate to the Data Lake Compute (DLC) console and click Go to CVM to authorize Data Lake Compute.

This service requires creating service roles

u‘r |

2. In Role Management, click Grant.

Purchasing an Engine

A Note:
Financial permissions are required in CAM (Cloud Access Management).

1. On the Data Lake Compute (DLC) console, you can navigate to the engine purchase page through the Overview and

Data Engine pages to purchase an engine.

Overview Page > Initial Configuration > Purchase Data Engine:
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Overview ) Guangzhou +

Data Lake Compute overview

Data Lake Compute

Tencent Cloud Data Lake Compute provides agile and efficient data lake analytics and compute services through its serverless architecture. With storage and compute separated, it offers cost-effective options and enables imperceptible resource

auto-scaling. It also allews you to use standard SOL statements to perferm joint analytics and compute with COS and other cloud data services.

[ Data management Data Explore Data engine

a

@ Create query
) Create database
Data overview
Total data volume(7) Managed storage usage(7) Private clusters(i) CU usage yesterday(i)
0 CUs
Data engine
Create compute engine
6 @ 3 i @ @
@ @
2 0 0 0 0 0

Data engine © Guangzhou ~ Dat vide &2
Data engine Network configuration
e e ot ot ke et T et et x
more biling info e Blling Overview . A pay-s5-y0u-02 G
ot Qo

@

-]

2. Select the type of engine you wish to purchase on the purchase page:

@® Note:
SparkSQL: Suitable for stable and efficient offline SQL tasks.

Spark Job: Suitable for native Spark streaming/batch data job processing.

Presto: Suitable for agile and rapid interactive query analysis.

©2013-2023 Tencent Cloud. All rights reserved.
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Data Lake Compute s«

Documentation 2 Biling2 Console 4

Engine edition SuperSQL engine Standard engine
Billing mode Pay-as-you-go Monthly subscription ~ Detailed comparison

Region

Beijing Nanjing Shanghai Shanghai Finance Chengdu Chongaing Silicon Valley Singapore Virginia

Frankfurt Beijing Finance Hong Kong

| Cluster configuration

Basic configuration

Compute engine type SparksaL Spark job “

A Note:

The scale of a 6CU cluster is relatively small, it is recommended for testing scenarios only. For real production
scenarios, it is advisable to select a cluster specification of 64CUs or above.

Team Account Activation

If you have a demand for multiple accounts to use the product collaboratively, you can follow the suggested operations
below to enable it:

1. Permissions are not universal across each region; different regions require separate configuration of corresponding
permissions.

2. Quick access to Data Lake Compute (DLC) permissions:

To grant a sub—account access to Data Lake Compute (DLC), please navigate to the CAM Console for
configuration.

To enable sub—account read and write permissions for data and engines within the Data Lake Compute (DLC)
product, please go to the DLC console for configuration.

Granting Sub—account Access and DLC Permissions

The primary account inherently possesses all operational permissions for Data Lake Compute (DLC). The primary
account can grant DLC access permissions to sub—users through Cloud Access Management (CAM), enabling the sub-
users to have corresponding DLC operational permissions: QcloudDLCFullAccess (Full operational permissions for
DLC).

Instructions

1. Log in to the CAM Console to create a sub—user. For detailed operations, please refer to Creating and Authorizing a
Sub-account.
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2. Add the preset policy QcloudDLCFullAccess (full operational permissions for DLC) to the sub—account.

You can search for the user to be authorized in the user list and click Authorize.

Granting sub—account permissions for data and engines in DLC

Adding Users to DLC Permission Management

@® Note:
1. Please confirm the region where the user permissions take effect.

2. Regarding User Segmentation:
Administrator: Possesses permissions to all resources.

Regular users: Specific permissions need to be granted, or they can be associated with a workgroup to
obtain permissions.
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1. Log in to the Data Lake Computing DLC Console, navigate to the Permission Management page, select the
corresponding service region, and proceed to the Permission Management page. Click on Add User.

Data Lake Compute Permission management ® Guangzhou ~ Use guide ¥ Permission management quide [

User  Workgroup

@  Both sub-account and coordinator users need to be granted with permissions to use data, engines, and other resources. A user may be associated with one or more work groups ta inherit all of their permissions. An admin user has all resource permissians. For more permission guidelines, see x
here &4

Add user Batch delete Qo
User ID Username User type @ Description Added by Add time # Operation

A = [ 2023-03-07 16:5641

2. Add the account to DLC for management using the sub—user's CAM ID. Please select the user type as per your
requirements.

3. Associating users with a workgroup (This step is optional).

@® Note:
If you need to manage the usage permissions of multiple users, you can do so by associating them with a
work group. After the work group is created, you can proceed with the addition. For the specific creation
process, please refer to Getting Started with DLC Permission Management in One Minute.

Bind work group X

Select a work group. Selected (0)

Add Engine and Data Permissions

After creating a user or workgroup, click on the authorization operation in the list to add permissions to the workgroup,
including data permissions and engine permissions.
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Permission management © Guangzhou ~ Useguide @ Permission management guide (2
User  Work group
@ 5ot sub-account and coordinator users need to be oranted with permissions to use data, engines, and other resources. A user may be associated With One of more work groups ta inhert 2l of their permissions. An a0min user has 3l resource permissions. For more permission guideines, see here [ X
User 1D Username ser type @ Description Added by Add time & Operatior
1t “ - 2023-12.05 16:49:02

20231122 145311 Edit

Data Permissions

Data Directory Permissions: This includes the authority to create databases and data directories within the data
directory.

Add permission X

Permission t :-;OCataICg Database & table

Permission Create database under DatalakeCatalog Create cataleg

Database Table Permissions: Fine—grained permissions at the database table level can be granted, including query and
edit permissions for databases, tables, views, and functions.
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Add permission X

Cataleg o Database & table

DatalakeCatalog v
Setting mode Advanced
atabase Select a database/view/function Selected (0)
Q Q
Query analysis @ Edit data () Owned by @

Engine permission

Based on the usage scenarios of the user or workgroup, select the engine's permission policies.

@® Note:
Utilization: Employ this engine for task execution.

Modification: Alter the configuration parameters of the engine, such as adjusting the engine's specifications.
Operation: Pause and suspend the engine.

Monitoring: Operational oversight of engine usage.

Deletion: Proceed to remove the engine.

Grantable: If checked, all members of this sub—user or workgroup will have the authority to grant permissions
to the engine.
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Add permission -

Use Modify Operation Monitor
Delete

Yes

Configuring the Result Storage Location

Before using the data exploration feature, you need to configure the query result path. Once configured, the query
results will be saved to the specified COS path or DLC's managed storage. For detailed operations, please refer to the
Guide to Configuring Query Result Paths.

Configuring the Result Storage Location

Navigate to the Data Lake Compute (DLC) console, select the data exploration feature, choose the configuration for the
result storage location, and click Configure.

uuuuuuu Que o+ XX Storage configuration

Select the location and method of storage

@® Note:
Metadata Acceleration Bucket: In the current region, it can significantly enhance query analysis performance.
Internal tables can be directly enabled, while external tables require confirmation if the engine permission
allows enabling.

Please note: Shared engines cannot bind to metadata acceleration buckets. When a user selects a user
storage path, the exclusive engine needs to bind to the metadata acceleration bucket first, and then the query
can take effect.

User Storage: User storage refers to your bucket path on COS.

©2013-2023 Tencent Cloud. All rights reserved. Page 11 of 32


https://cloud.tencent.com/document/product/1342/72493#.E9.85.8D.E7.BD.AE.E6.9F.A5.E8.AF.A2.E7.BB.93.E6.9E.9C.E8.B7.AF.E5.BE.84
https://console.cloud.tencent.com/dlc/data-exploration

&2 Tencent Cloud Data Lake Compute

Establishing a Database

Before creating a database, choose the engine to be utilized.

Data Explore © Guangzhou ~ SQLsyntax reference (2 Data ex;

1. Select the engine to be bound

Enter the database name and click Confirm.

Create database X

Create table
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Native Table: This is your table stored on the managed storage of Data Lake Compute (DLC), by default in Iceberg
format. Using a native table eliminates the need to manage underlying Iceberg files and provides data optimization
capabilities to help build a data lake.

DataBxplore  © Guangahou ~ SQU iyt eference 2 Dt explore guide

Database  Query O+ uey22i207.e | + v 2 Sorage configuation

a R - G fere & romst | R e e [ publieenginelSuperSQLR 10mpubli) T

*, "errlesc”:"SQLs musber invalid The number of SOL must be graster then or equal to 1 and Less then or equal to 80.", “ersCode” "60003", “ernlsg”s "}

DOO00000000000000 - -

External Table: This refers to tables stored in your own COS bucket or other third—party data storage. DLC can directly
create external tables for analysis without the need for additional data loading.

Selecta COS path

A Note:
After creating a native table, you need to refresh your browser before you can use it.

Data Query

Navigate to the Data Lake Compute (DLC) console — Data Exploration. On the analysis page, you can create SQL
queries. The features support full execution, partial execution, result download, and materialized views.
For details on SQL syntax, please refer to SQL Syntax.
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Data Lake Compute Data Import Guide

Last updated: 2024-01-10 15:52:36

Importing External Table Data via COS

Data Lake Compute (DLC) supports querying and analyzing data directly on COS without migrating data. Therefore, you
only need to import the data into COS to start using DLC for seamless data analysis, achieving complete decoupling of
data storage and computation. Currently, it supports uploading a variety of formats such as orc, parquet, arvo, json, csv,

and text files.
At present, COS offers a wealth of data import methods. You can choose the following methods to import data

according to your own situation.
Loginto COS and directly upload files. For related operation steps, please refer to Uploading Objects.
Import data using various upload tools provided by the COS service. For a list of supported tools, please refer to Tool
Overview.
Import data using the SDK or API provided by the COS service. For service-related instructions, please refer to
Upload Interface Documentation.
If you need to import logs from CLS for analysis, you can directly deliver the logs to COS according to partitions and
then directly analyze and query them using DLC. For related operations, please refer to Using DLC (Hive) to Analyze
CLS Logs.
If you need to import data from other cloud services (such as CDB databases) into COS, you can use DatalnLong for
the import. When creating a data synchronization link, select the cloud service that needs to be exported as the data
source, and select COS as the destination to complete the data import. For more information on how to use the data
integration service, please refer to Data Integration.
If you encounter any issues during data import, you can consult us for solutions by submitting a ticket.
After importing data into COS, you can use the DLC console, API, or SDK to perform SQL queries, table creation,
analysis, result export, and other operations. For detailed operations, please refer to Getting Started with DLC Data
Analysis in One Minute.

Importing Data into Native Tables

To provide better data query performance, Data Lake Compute (DLC) also supports querying and analyzing data after
importing it into native tables. DLC native tables arrange data based on the Iceberg table format and optimize the data
during the import process. If you have the following use cases, it is recommended to use native tables for data query

analysis.
In the context of data warehouse analysis scenarios, it is desirable to leverage Iceberg indexing for improved

analytical performance.
If there is a need to update data, it can be achieved through the DLC service using SQL or data jobs to perform
UPSERT operations.
Data is updated in real-time through Data Integration DatalnLong, Flink, Stream Compute Oceanus, Spark
Streaming, with simultaneous reading and writing, suitable for data processing businesses that require transactional
guarantees.
If you wish to utilize features related to Iceberg tables, such as time travel, multi-version snapshots, hidden
partitioning, and partition evolution, among other advanced data lake features.
If you need to import data into a native table, you can choose the following methods to import data according to your
own situation.
Import directly through the Data Lake Compute DLC Console. For detailed operation steps, please refer to COS
Data Import.

A Note
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When importing data via the console, there are certain usage restrictions. It is mainly used for quick testing
and is not recommended for production use.

If your original data is in MySQL, Kafka, etc., and you need to write/update MySQL binlog, middleware data to DLC in
real-time every minute, you can achieve this through the real-time import capability of Datalnlong. For detailed
operation steps, please refer to DLC Real-time Data Import and Small File Merge. Alternatively, you can write
through Stream Compute Service or Flink. If you need operation guidance, please contact us through Work Order.
If the original data is in MySQL, Kafka, MongoDB, etc., you can use the offline synchronization task of DatalnLong to
transfer the data to the native table (for creation steps, see Creating Offline Synchronization Tasks). During the data
warehouse modeling process, the external table is used as the original data source layer. In the process of
transferring data to the native table, you can rearrange the data distribution in conjunction with the business by
building sparse indexes, etc., to achieve excellent native table query analysis performance. If you need guidance,
please Contact Us.

Use the SELECT INSERT method in SQL syntax to query the data from the external table and write it into the native
table. For example, after creating a native table with the same structure as the external table in DLC, complete the
transfer by executing SQL syntax through the SparkSQL engine. The syntax example is as follows:

--- External table name: outtertable, Native table name: innertable

insert into innertable select * from outtertable

If you encounter any issues while importing data, please submit a ticket and we will provide you with a solution.

Federated Query Analysis Across Multiple Data Sources

If you do not wish to export data to COS or the native tables of DLC, Data Lake Compute also provides data federation
query analysis capabilities. It allows you to quickly associate and analyze data from multiple data sources using SQL
without migrating data. Currently, it supports a variety of data sources including MySQL, SQLServer, ClickHouse,
PostgreSQL, EMR on HDFS, and EMR on COS. For instructions on adding a federated analysis data directory, please
refer to Data Directory and Database Management.
When using federated analysis, the data source and data engine need to be in the same network. For network
connectivity and management, please refer to Engine Network Configuration.
When analyzing EMR data through Data Lake Compute (DLC), the query performance will be on par with or even
exceed that of EMR, making it suitable for production environments. Without migrating EMR services, you can fully
utilize the fully managed and elastic capabilities of DLC to reduce costs and increase efficiency.
Federated analytics can quickly combine data from multiple sources for analysis, providing a convenient way for
data insights and rapid analysis. Relying on the fully managed and elastic capabilities of DLC, it can effectively
reduce usage costs. It also supports the use of INSERT INTO/INSERT OVERWRITE syntax to write federated data
into DLC native tables, completing data import.
When federating analysis from other data sources, there is a certain performance loss compared to direct queries
from the original data source, as the data needs to be synchronized to DLC for analysis during the computation
process. If high query performance is required, you can import the data into the native table for analysis. For
operation methods, please refer to Importing Data into Native Tables.
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Quick Start with Data Analytics in Data Lake
Compute

Last updated: 2024-01-10 15:52:43

With Data Lake Compute, you can complete data analysis queries on COS in just a minute. It currently supports multiple
formats including CSV, ORC, PARQUET, JSON, ARVO, and text files.

Preliminary Preparations

Before initiating a query, you need to activate the internal permissions of Data Lake Compute and configure the path for
query results.

Step 1: Establish the necessary internal permissions for Data Lake Compute.

@® Note
If the user already has the necessary permissions, or if they are the root account administrator, this step can be
disregarded.

If you are logging in as a sub—account for the first time, in addition to the necessary CAM authorization, you also need to

request any Data Lake Compute admin or root account admin to grant you the necessary Data Lake Compute

permissions from the Permission Management menu on the left side of the Data Lake Compute console (for a detailed

explanation of permissions, please refer to DLC Permission Overview).

1. Table Permissions: Grant read and write operation permissions to the corresponding catalog, database, table, and
view.

2. Engine Permissions: These can grant usage, monitoring, and modification rights to the computation engine.

O Note
The system will automatically provide each user with a shared public-engine based on the Presto kernel,
allowing you to quickly try it out without the need to purchase a private cluster first.

For detailed steps on granting permissions, please refer to Sub—account Permission Management.

Step 2: Configure the path for query results.

Upon initial use of Data Lake Compute, you must first configure the path for query results. Once configured, the query
results will be saved to this COS path.
1. Log in to the Data Lake Compute DLC console and select the service region.

2. Navigate to Data Exploration via the left sidebar menu.

3. Under the Database and Tables page, click on Storage Configuration to set the path for query results.
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Data Explore ® Guangzhou ~ SQL syntax re
Database Query O+ Query-2023-1207.. @  + +
[GB Coialog  DatalakeCatalog - %) Running @ Save e & Format | G =] =]

L U IR IR BRI ]

Query result Run history Download histery | A

Specify the COS path for storage. If there are no available COS buckets in your account, you can create one through
the Object Storage Console.

Storage configuration ¥

® Enable

General bucket

@ Managed storage User-defined storage
(|
Cancel
Analysis Steps

Step 1: Create a Database

If you are familiar with SQL statements, write the CREATE DATABASE statement in the query and skip the creation
wizard.
1. Log in to the Data Lake Compute DLC console and select the service region.

2. Navigate to Data Exploration via the left sidebar menu.

3. Select Database, click +, choose Create Database to establish a new database. As shown below:

Data Lake Compute Data Explore ©) Guangzhou - SQLsyntax reference 2 Data explore guice B2
1. Click the "+" button
Datab. f+) cwenzsrarn.e | + - £ storage configuration
@ Data Explore Catsiog | DataLakeCatalog c || B S B rormat | L] =]
< P "
—— c 2. Click "Create a database
=
Data > B Tl
> B View
Data Engines
> @
=
> @ T
3 View

Enter the database name and its descriptive information.
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Create database X

4. After selecting the execution engine in the upper right corner, execute the generated 'create database' statement to
complete the database creation.

Data Explore € Guangzhou ~ 5L syntax reference [4 Data explore guide [2
Database Query @ + | Query-2023-12-07.. @ | + ~ XX Storage configuration
(OB Cotziog  DatalskeCatslog - [ save Q Refrach B3 Farmat | D S

1 CREATE DATABASE IF NOT EXISTS ~DatalakeCatalog .  test’

'S
=
=r
re
> om
= F

The details are as shown below:

Database Query o+ Query-2023-12-07.. @ | + ~

Catalog | DatalakeCatalog v Partial run [B save 3 Refrash 2 Farmat o

1 CREATE DATABASE IF NOT EXISTS ~DatalLakeCatalog’ . test”
&
=
re.

For detailed operation steps and configuration methods, please refer to Database Management.

Step 2: Create an External Table

If you are familiar with SQL statements, write the CREATE TABLE statement in the query and skip the creation wizard.
1. Log in to the Data Lake Compute DLC console and select the service region.

2. Navigate to Data Exploration via the left sidebar menu.

3. Select the database/table, right—click on the newly created table, and choose Create External Table.

@® Note

External tables typically refer to data files stored in your own COS bucket. Data Lake Compute can directly
create external tables for analysis without the need for additional data loading. Given the characteristics of

external tables, actions such as executing 'drop table' will not delete your original data in Data Lake Compute,
but only the metadata of the table.
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Data Lake Compute Data Explore © Guangzhou ~ SQL syntax reference [2  Data explore guide [4
Database Query O+ Query-2023-1207.. @ | + XX Storage configuration
Catzlog | DatslakeCatalog v m B save e} £ format | @ ® A=
1 CREATE DATABASE IF NOT EXISTS ~DatalakeCatalog . test’ Tl

4. Follow the guide to generate the table creation statement, completing each step in the following order: Data Path >
Data Format > Data Format Configuration > Edit Partition.

Step 1: Select the COS path where the data files are stored (the path must be a directory under the COS bucket,
not directly to the COS bucket). A shortcut for quickly uploading files to COS is also provided here. This operation
requires relevant COS permissions.

Currently, Data Lake Compute supports the creation of: File, CSV, JSON, PARQUET, ORC, AVRD

@® Note
Structure inference is an auxiliary tool for table creation and cannot guarantee 100% accuracy. You still
need to review and verify whether the field names and types meet your expectations, and edit them to the
correct information based on the actual situation.

Create external table X

Select a COS path

Text file (Log, TXT, and others)
csv

JS50N

PARQUET

ORC

AVROD

nfer structure

Field name Field type Field configuration Operation

No data

Step 3: If there are no partitions, you can skip this step. Enabling partition use can reasonably enhance analysis
performance. For detailed partition information, refer to Query Partition Table.
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«©

Partition field Partition type Operation

Insert Delete

O

5. Click Complete to generate the SQL table creation statement. Execute the generated statement after selecting the
data engine to complete the table creation.

Database Query QO+ Query-2023-12-07.. @ + XX Storage configuration
Catalog ~ DatalakeCatalog v Partial run B save o) 3 Format | Ea = = -
1 CREATE EXTERNAL TABLE IF NOT EXISTS “DatalakeCatalog’. il . demotest™ (
2 *_co string,
. 3 ‘e string,
e 4 *_c2 string,
> 3 Table 5 *_c3 string,
5 *_ea string, L
» B3 View 7 7 _c5 string
[ 8 ) ROM FORMAT SERDE 'org.apache.hadoop.hive.serde2.0penCsVSerde’ WITH SERDEPROPERTIES (separatorChar’ = ',°, 'quoteChar’ = *"*) STORED AS TEXTFILE LOCATION 'COSN://anaas 2mii]
» [ Function
1 -E
@

Step 3: Execute SQL Analysis

After the data is prepared, write the SQL analysis statement, select an appropriate compute engine, and start data
analysis.

Database Query © + | Query-2023-1207..®  + ~ XX Storage configuration
Catalog | DatalakeCatalog v Complet ™ B save o £3 Format | & =]

e T B public-engine(SuperSQL-P 1.0-public) ™
1 BELECT * FROM 'DatalakeCatalog’."demo” . test_1' LIMIT 10; Tl

R
e
e
=
=]
v BB Table
H test 1
B et 2
» B8 View

* B Function

e
> e
e
> -, Query result  Statistics Run history Download history | A v
=
T Task 1D SQLdetails Export Suggestions 2

= 3 | Quer e 3.05s Scanned datavolume 27 KB Billable scanne e 30ME @
F e, 10 entries in total (up to 1,000 entries shown in the console)CopyTE
e pro_name price pro_date
- 12 product12 133 20230712 2
»

S 6 productt 153
e

10 product10 143 20230712

Sample

Write a SQL statement with all data query results being SUCCESS and run the statement after selecting a compute
engine.

select * from DatalakeCatalog.demo2.demo_audit_table where _c5 = 'SUCCESS'

The execution result is as follows:
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Query result

Task ID SQL

s Export Suggestions 4

1915 20KB 340M8 @
9 entries in total (up to 1,000 entries shown in the console)Copy I
5 progucts iEES 20230712
14 productl4 EES 20230712
12 product12 {EES 20230712
8 product8 163 20230712
2 product2 133 20230712
5 proguctt 153 20230712
10 proguct10 143 20230712
1 product] 123 20230712
4 productd 143 20230712

©2013-2023 Tencent Cloud. All rights reserved. Page 22 of 32



&2 Tencent Cloud Data Lake Compute

Quick Start with Permission Management in Data
Lake Compute

Last updated: 2024-01-10 15:52:50

During the utilization of Data Lake Compute (DLC), if you need to establish varying access permissions for employees
within your organization to achieve isolation of authority among them, you can employ the permissions management
feature for meticulous management of user and workgroup permissions.

A Note:

1. The policy of permissions is highly correlated with the usage of the product. It is recommended that
administrators configure the policies for roles such as workgroups and sub—users in advance before officially
utilizing the product features.

2. In different regions, administrators are required to reconfigure the member management and permissions
management for DLC in that specific region.

CAM Authorization

Data Lake Compute (DLC) possesses a comprehensive data access permission mechanism. If you have sub—-account
management requirements, please grant the corresponding sub—account with the QcloudDLCFullAccess (Full read-
write access to Data Lake Compute (DLC)) policy in the Access Management Console. For specific steps on creating
sub—accounts and authorizing policies, please refer to Creating and Authorizing Sub-accounts.

Data Lake Compute (DLC) offers permissions refined to the granularity of row and column levels in data tables, ensuring
that you need not worry about overstepping authority with this operation.

[ Mpoices | presetpoliy | Custompoices | | dc o als s

2023-10-18 163133

2023-10-18 16:3123

Users and Workgroups

Data Lake Compute (DLC) manages user permissions through two methods: granting permissions to users and binding
workgroup authorizations.
User: Users in CAM, encompassing administrators, sub—accounts, and collaborator accounts.
Workgroup: Data Lake Compute (DLC) allows for the binding of a group of users to a workgroup, granting the group
permissions for data, engines, and other resources. This facilitates bulk management of user permissions, with
users within the same workgroup possessing identical permissions.

® Note
When the permissions assigned to a user differ from those of their work group, the union of both sets of
permissions is taken.
By default, ordinary users created by the administrator do not have any permissions. They need to be
added to a work group and the corresponding permission policies need to be granted to the work group in
order for the users within the group to obtain the respective permissions.
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Adding a User

Data Lake Compute utilizes the Tencent Cloud account ID as the default user ID. It distinguishes between two user
types: administrators and ordinary users. Administrators inherently possess all resource permissions, while ordinary
users must be granted specific permissions or be associated with a work group to acquire permissions.

1. Incorporate a user and associate them with a work group.

Log into the DLC console, select Permission Management, and click on Users > Add User to incorporate a new user.

Permission mana, igement © Guangzhou ~ Use guide &% Permission management guide £

2023-12-06 17:352¢ Edit Authorize ¥ Delete

2023-03-07 16:56:41

2. Enter the basic information: Provide the user ID, user name, and description, and select the user type.

@® Note:
When selecting the user type as "Ordinary User", permissions can be obtained through individual
authorization or by acquiring all permissions of a specified work group. When selecting "Administrator" as the
user type, there is no need to associate with a work group to gain all permissions.

3. Associate with a work group: Select a work group for association (optional).

Bind work group X

Select a work group Selected (0)

D Name Description

User authorization

In the user list, authorize each user individually. The authorization includes "Data Permissions" and "Engine
Permissions", and the permission policy is consistent with the work group's permission policy. For more detailed
operations, refer to Sub—account Permission Management.
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Permission management ) Guangzhou ¥
User Work group

Data Lake Compute

Use guide & Permission

@  Both sub-account and coordinator users need to be granted with permissions ta use data, engines, and other resources. A user may be associated with one or more work groups to inherit all of their permissions. An admin user has all resource permissions. For more permission quidelines, see here [

Add Work Group

Add time

2023-12-06 17:35:24

2023-03-07 16:56:41

Operation

1

management quide [2

Delete

/1page

1. In the Data Lake Compute DLC, select Permission Management from the left sidebar, and click on Work Group >
Add Work Group to create a work group for the user. When creating a work group, you can choose to bind it to a user

or create an empty work group. For detailed operations, refer to Users and User Groups.

Permission management &) Guangzhou +

User  Werk group

@  Batch add users to a work group to batch grant them the permissions of data, engines, and other resources of this work group. There is no need to add an admin to a work group. For more permission guides, se< here

Add work group Batch remove

Work group ID Work group name User count Description

2. Enter the basic information: Provide the work group name and description.

< Add work group

o Basic info >

No data

2

Use guide &

3. Associate a user: The associated user will acquire all permissions under the respective work group.

< Addwork group

° Basicinfo > o Bind user

Bind user An associated user will abtain all permission of this work group.

Usertype Description

Granting permissions to a work group.
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After creating the work group, click on the Authorize operation in the list to add permissions to the work group, including
Data Permissions and Engine Permissions.

Permission management © Guangzhou v Use guide 3 Permission management guide [2

User  Work group

®  Batch add users to a work group to batch grant them the permissions of data, engines, and other resources of this work group. There is no need to add an admin to a work group. For more permission guides, see here 4. x
Add work group. Batch remove Enter 3 work group name a o
Work group ID Work group name Usercount  Description Added by Add time Operation

Data permission
Total items: 1 /1page  » M

Engine permission

Data permission

Data permissions include:
« Data Catalog Permissions: These include two types of permissions under the data catalog, namely, the ability to
Create Database and Create Data Catalog.

Add permission X

Sermssion o @) Catslog | Database & table

Creste database under DatalakeCatalog | | Create catalog

« Database Table Permissions: Fine—grained permissions at the database table level can be granted, including query
and edit permissions for databases, tables, views, and functions.

Add permission X

DatalakeCatalog

Select a database/view/function Selected 3)
Q Q

Al =

- - i a1 Table
> [ Ebe
+ O] Eview el View
> [ EFunction « -

4 ©s

4 &

IRE-The

» =

y e

Queryanalysis @ ( Editcas @ ) Ownedby @

Engine permission
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Select a data engine and grant the permissions to use, modify, or delete it.
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Quick Start with Partition Table

Last updated: 2024-01-10 15:53:16

Partitioned Table in Data Lake Compute

With the partition catalog feature, you can store data with different characteristics in different catalogs. In this way,
when exploring data, you can filter data by partition through the where condition. This greatly reduces the scanned
data volume and improves the query efficiency.

A Note
» Partitions within the same table should utilize the same data type and format.

« Data Lake Compute's native tables implement implicit partitioning, allowing you to disregard the partition
directory structure.

Creating a Partitioned Table

Specify the partition field through the PARTITIONED BY parameter in the table creation statement.
Example: Creating the test_part partition table

CREATE EXTERNAL TABLE IF NOT EXISTS DatalLakeCatalog.test a_db.test_part (
_cO int,
_cl int,

_c2 string,
dt string
) USING PARQUET PARTITIONED BY (dt) LOCATION 'cosn://testbucket/data/';

Add Partition
Add partitions using the alter table add partition command.

If your data partition catalog uses the Hive partitioning rule (partition column name=partition column value), the rule can
be used to add partitions. The catalog is organized as follows:

testbucket

.

/dt=202206 /dt=202207 /dt=202208 /dt=202209 /dt=202210

ALTER TABLE DatalakeCatalog.test_a_db.test_part add PARTITION (dt = '202206")
ALTER TABLE DatalakeCatalog.test_a_db.test_part add PARTITION (d '202207")
ALTER TABLE DatalakeCatalog.test_a_db.test_part add PARTITION (d '202208")
ALTER TABLE DatalLakeCatalog.test a_db.test part add PARTITION (d '202209')

(dt = '202210')

ALTER TABLE DatalLakeCatalog.test a_db.test part add PARTITION

Add partitions by specifying the location with the alter table command.

If your data adopts a general COS catalog (not in the "partition column name=partition column value" format), you can
specify a catalog when adding a partition.
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Sample SQL:

ALTER TABLE DatalakeCatalog.test_a_db.test_part add PARTITION (dt = '202211') LOCATION
‘cosn://testbucket/data2/202211"

ALTER TABLE DatalakeCatalog.test_a_db.test_part add PARTITION (dt = '202212') LOCATION
‘cosn://testbucket/data2/202212"

Utilizing MSCK REPAIR for Automatic Partition Addition

By using the MSCK REPAIR TABLE statement, the system scans the data directory specified during table creation. If new
partition directories exist, the system will automatically add these partitions to the metadata information of the data
table.

SQL Reference:

MSCK REPAIR TABLE DatalLakeCatalog.test a_db.test part

We recommend adding partitions primarily through the 'alter table' method. If you choose to use 'msck repair’ for
automatic partition addition, the following constraints apply:
» The MSCK REPAIR TABLE command only adds partitions to the table metadata, it does not delete partitions.
» When dealing with large volumes of data, it is not recommended to use the MSCK REPAIR TABLE method, as it
scans the entire data volume and may lead to timeouts.

o If the partition directory does not follow Hive's partitioning rule: partition column name = partition column value, the
MSCK REPAIR TABLE method cannot be used.
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Cross—Source Analysis of EMR Hive Data

Last updated: 2024-01-10 15:53:22

Data Lake Compute allows you to configure an EMR Hive data source for multi-source federated data analysis.

Preparations

Acquire the EMR Hive address.

Use an account with the authority to create data directories. For detailed permissions, refer to DLC Permission
Overview.

Create an EMR Hive Data Source

1. Log in to the Data Lake Compute DLC console and select the service region.

2. Navigate to Data Exploration via the left sidebar, click the +button in the library table column, and select Create
catalog.

Data Explore '@ Guangzhou ~
Database Query Query-2023-12-11 ... @
Catalog = DatalakeCatalog Create 2 dstabase | @
I Create catalog I

3

3. Select the connection type as EMR Hive (HDFS), choose the corresponding EMR instance, and the VPC information
will be automatically filled in after the instance is selected. EMR Hive supports the following EMR versions: 2.3.5,
2.3.7,31.1,31.2.

A Note
You must have the relevant permissions for the EMR Hive instance to make a selection.
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Create catalog

o Catalog ?

configuration
_onnection type * EMR Hive(HDFS)
nection name = hdfs_demo

Description hdfs_demo

(#]

vailable

Teee ; ) '_A

Hive version * 2.3.5

tore. The address can be queried in the EMR console

=
=

o .r:\l
de (@)

Mext

4. Select the running cluster. Currently, only Presto private data engines are available. If there is no corresponding
engine, you can create a data engine on the data engine page. For the purchase process, please refer to Purchasing

a Private Data Engine.

A Note
The selected data engine IP range must not coincide with the EMR instance IP range, as this would lead to

network conflicts and hinder data query analysis.

5. Click Confirm to complete the creation of the data directory.

Query EMR Hive Data

Once the data directory is created, you can switch data directories from the data directory menu on the Data

Exploration page.
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Database Query 0+ Query-2023-12-11.. @ @+ ~

Catalog = DatalakeCatalog v m B save L & Format EE
1

At this point, you can use SQL statements to query and analyze the data directory. For SQL syntax, please refer to SQL
Syntax Overview.

Select the data engine bound when creating the data directory and click the Run button to obtain the query results.

A Note
Only the associated data engine can query this data directory, other data engines will not be able to perform
queries. If you need to change the associated engine, you can click the settings button next to the data directory

to edit and modify.
Data Explore &) Guangzhou ~

Database 0+

Catalog | we A ] b E

I Maodify configuration I

=)
C
m

Delete
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